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1 System Description

1.1 Cautions and Warnings
This TI design operates the hardware powered directly from AC supply; therefore, only professionals who
received appropriate technical training should operate the hardware.

Before operating the hardware, read the safety related documents that come with the user’s guide before
operating the hardware.

CAUTION
Read the user's guide before use.

CAUTION
Do not leave the EVM powered when unattended.

CAUTION
HOT SURFACE: Contact may cause burns. Do not
touch.

CAUTION
HIGH VOLTAGE: Electric shock is possible when
connecting the board to a live wire. The board should
be handled with care by a professional. For safety, use
isolated equipment with overvoltage and overcurrent
protection.
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1.2 System Description
This design guide discusses an application that reads an energy monitor device over a Wi-Fi link. This
design uses the Texas Instruments CC3200MOD and MSP430i2040 as the development platform for
communication and electrical metering, respectively. Starting from the TI Design TIDM-3OUTSMTSTRP
as the metering data source, a communication board designed using the CC3200MOD is added for Wi-Fi
communication. The metering data can then be read and the relay can be controlled by using a browser.

This guide explains the process of coding the CC3200 to add the communication to the TIDM-
3OUTSMTSTRP.

1.3 MSP430i2040 — 16-Bit Mixed Signal Microcontroller
The MSP430i2040 is used in this design as the metrology processor. Its four 24-bit sigma-delta analog-to-
digital converters (ADCs) allow accurate energy measurements, providing read of voltage, current, power
(active, reactive, apparent), power factor, and frequency of three AC outlets. The MSP430i2040 requires
only a few passive external components to interface directly to the voltage divider and current shunt for
voltage and current measurements.

1.4 CC3200 — SimpleLink™ Wi-Fi CC3200 Internet-on-a-Chip™ Wireless MCU Module
The CC3200MOD is used in this design as the Wi-Fi controller that integrates an ARM® Cortex™-M4
MCU, allowing customers to develop an entire application with a single device. With on-chip Wi-Fi,
Internet, and robust security protocols, no prior Wi-Fi experience is required for faster development.
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2 Block Diagram

Figure 1. System Block Diagram
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2.1 Highlighted Products

2.1.1 MSP430i2040 — 16-Bit Mixed Signal Microcontroller
• Supply voltage range: 2.2 to 3.6 V
• 16-bit RISC architecture, up to 16.384-MHz system clock
• Memory

– Up to 32KB of Flash main memory
– 1KB of Flash information memory
– Up to of 2KB of RAM

• Clock system
– 16.384-MHz internal DCO
– DCO operation with internal or external resistor
– External digital clock source

• Up to four 24-bit sigma-delta ADCs with differential PGA inputs
• Two 16-bit timers with three capture/compare registers each
• Enhanced universal serial communication interfaces (eUSCIs)

– eUSCI_A0
• Enhanced UART with automatic baud-rate detection
• IrDA encoder and decoder
• Synchronous SPI

– eUSCI_B0
• Synchronous SPI
• I2C

• 16-bit hardware multiplier

2.1.2 CC3200 — SimpleLink Wi-Fi CC3200 Internet-on-a-Chip Wireless MCU Module
• Consists of the CC3200R1M2RGC single-chip wireless MCU and all required clocks, SPI flash, and

passives.
• Modular FCC, IC, and CE certifications save customer effort, time, and money
• Wi-Fi certified modules, with ability to request certificate transfer for Wi-Fi alliance members
• 1.27-mm pitch LGA package for easy assembly and low-cost PCB design
• Efficient code size architecture, placing drivers, Bluetooth® low-energy controller, IEEE 802.15.4 MAC,

and Bootloader in ROM
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2.1.3 UCC28910, UCC28911 High-Voltage Flyback Switcher
• Constant-voltage (CV) and constant-current (CC) output regulation without optical coupler
• ±5% output voltage regulation accuracy
• ±5% output current regulation with AC line and primary inductance tolerance compensation
• 700-V start-up and smart power management enables <30-mW standby power
• 115-kHz maximum switching frequency design for high-power density
• Valley switching and frequency dithering to ease EMI compliance
• Thermal shutdown
• Low line and output overvoltage protection

2.1.4 ULN2003LV 7-Channel Relay and Inductive Load Sink Driver
• 7-channel high current sink drivers
• Supports up to 8-V output pullup voltage
• Supports a wide range of 3- to 5-V relay and inductive coils
• Low output VOL of 0.4 V (typical) with

– 100-mA/140-mA (typical) current sink per channel at 3.3-V/5.0-V logic input
• Compatible to 3.3-V and 5.0-V MCUs and logic interface
• Internal free-wheeling diodes for inductive kick-back protection
• Input pulldown resistors allows 3-stating the input driver
• Input RC-snubber to eliminate spurious operation in noisy environments
• Low input and output leakage currents
• Easy-to-use parallel interface
• ESD protection exceeds JESD 22: 2-kV HBM, 500-V CDM
• Available in 16-Pin SOIC and TSSOP packages
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3 System Design Theory

3.1 Metering
This TI Design uses the MSP430i2040 as the metrology processor. The TI Design TIDM-3OUTSMTSTRP
is used as the platform of the metering part. The hardware and firmware are slightly modified to add relay
control alighted to zero crossing. Find details on the hardware and firmware of the TIDM-3OUTSMTSTRP
in its TI Design folder; the modification to hardware is discussed in Section 4.

NOTE: The software package includes the modified firmware with the source code (except the
metrology source code, which is only provided upon request). Please contact a local sales
office for details on obtaining the metrology source code.

3.2 Metering Data Access
This TI Design uses the HTTP Web Server on the CC3200 transfer data from the MSP430i2040 metering
hardware. This transfer allows metering data to be accessed using a web browser on any platform.

The HTTP server listens on the HTTP socket (default to 80) then handles the request (HTTP GET or
HTTP POST) by retrieving the web page files from the serial flash. The server then calls to an HTTP event
handler to operate on the variable contents. It then composes an HTTP response and sends back to the
client over the Wi-Fi link.

Figure 2. Metering Data Access
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3.3 Handling Dynamic Data Items
To allow the metering data to be read with an HTML file with dynamic contents, the HTTP web server
supports a set of predefined tokens, which will be replaced on-the-fly by the server, with dynamically
generated content. Some tokens are predefined in the HTTP server with additional tokens that can be
defined in user application.

The HTTP server scans the HTML page for the "__SL_G_" prefix. If the server finds a prefix, it checks the
complete token. Once it matches a known token, it replaces the token in the HTML with the appropriate
data (string) that matches that token. If the token is not in the predefined list, the server generates a
get_token_value asynchronous event with the token name. This request eventually calls to the HTTP
event handler in the main.c code file. The handler then interprets the token and responds to the token
value with a send_token_value. The HTTP web server uses this token value and returns it to the client.

To send data from client to the HTTP server, the server will check for the "__SL_P_" prefix. Then the
server goes over the parameters list and checks each variable name to see if it matches one of the known
predefined tokens. If the variable names match the predefined tokens, the server processes the values. If
the HTTP web server receives an HTTP POST request that contains tokens not in the predefined list, the
server generates a post_token_value asynchronous event to the host, which contains the following
information: form action name, token name, and token value. The host can then process the required
information.

3.4 Implementation of HTTP Event Handler
According to Section 3.3, the HTTP event handler is implemented. To facilitate dynamic data, the user-
defined token is defined for the set of data to be retrieved:

User defined tokens:
• __SL_G_SST: Get Socket Status
• __SL_G_VSA: Get Socket A Voltage
• __SL_G_VSB: Get Socket B Voltage
• __SL_G_VSC: Get Socket C Voltage
• __SL_G_ISA: Get Socket A Current
• __SL_G_ISB: Get Socket B Current
• __SL_G_ISC: Get Socket C Current
• __SL_G_PSA: Get Socket A Active Power
• __SL_G_PSB: Get Socket B Active Power
• __SL_G_PSC: Get Socket C Active Power
• __SL_G_PFA: Get Socket A Power Factor
• __SL_G_PFB: Get Socket B Power Factor
• __SL_G_PFC: Get Socket C Power Factor
• __SL_G_H.D: Get Meter Name
• __SL_P_ULD: Set Socket Status

The HTTP event handler first checks for the type of event; in this application, only
SL_NETAPP_HTTPGETTOKENVALUE_EVENT and SL_NETAPP_HTTPPOSTTOEKNVALUE_EVENT
need to be handled. The process of the handling is illustrated in Figure 3.
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Figure 3. HTTP Event Handler Flow Diagram
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4 Getting Started: Hardware

4.1 TIDM-3OUTSMTSTRP Hardware Modification

4.1.1 Power Supply Circuit
The TIDM-3OUTSMTSTRP LDO circuit requires minor modifications to allow for more current to supply
the 3.3-V rail for driving the Wi-Fi block.

Figure 4. TIDM-3OUTSMTSTRP Hardware Modification

Change the LDO to TPS73633DBVREP . As this LDO is high enabled, the 0-Ω resistor R39 should be
opened and R59 should be added to connect pin3 to 5.0 V instead.

In addition to the LDO, replace the original power supply block to provide a more reliable relay operation,
although the block power supply in the original TIDM-3OUTSMTSTRP is sufficient to drive the whole
circuit.

Figure 5 shows the power supply design. This design is laid out with the same footprint as the original
power supply block (see Section 8 for detail of the layout) for drop in replacement.

Figure 5. 5-V Power Supply Block Schematic

4.1.2 Protection Circuit
Remove the following protection diodes (MOV) from the TIDM-3OUTSMTSTRP board: D11, D12, D2A,
D2B, D2C, D3A, D3B, and D3C.

4.2 Wi-Fi Module
The Wi-Fi module is designed using the CC3200MOD to facilitate attaching to the communication
connector on the TIDM-3OUTSMTSTRP board while providing the debugging and programming facility for
the CC3200. For details about the design of the Wi-Fi module, see Section 8.

10 Wi-Fi Link for Energy Monitoring TIDUAM2A–September 2015–Revised October 2015
Submit Documentation Feedback

Copyright © 2015, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAM2A


www.ti.com Getting Started: Firmware

5 Getting Started: Firmware
After the hardware is connected, download the firmware to its corresponding hardware.

5.1 Loading Firmware to Wi-Fi Module

5.1.1 Prerequisites
To debug with the CC3200MOD or to download the firmware to the flash memory on CC3200MOD, the
user needs:
• CC3200-LAUNCHXL or CC3200MODLAUNCHXL
• Code Composer Studio™ (CCS) Uniflash for CC3100/CC3200 installed on PC
• CCS 6.0.1 installed on PC
• Example code package unzipped and the folder "httpserver-powerstrip" copied into the cc3200dsk

example folder (located as default in C:\ti\CC3200SDK_1.0.0\cc3200-sdk\example\)
• Example code project imported to CCS and built

5.1.2 Connecting Board for Programming
On the CC3200-LAUNCHXL:
1. Disconnect the jumpers as indicated in Figure 6.
2. Locate the pins on J1 and J2 of the Wi-Fi module (Figure 7).
3. Connect the pins with a blue dot to the correspondingly labeled pin on the Wi-Fi module (Figure 6 and

Figure 7).

Figure 6. CC3200-LAUNCHXL Jumper Preparation for Connection to Wi-Fi Module
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Figure 7. Locate Pins on Wi-Fi Module
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5.1.3 Programming
Once connected as described in Section 5.1.2, set the Wi-Fi module to programming mode by switching
the SOP2 DIP switch on the Wi-Fi module to the ON position. Then:
1. Connect to the USB on PC with a USB cable to the micro-USB port on the CC3200-LAUNCHXL.
2. Launch CCS UniFlash for CC3100/CC3200 on PC.
3. Click on File → Open Configuration.

Figure 8. CCS UniFlash Open Configuration

4. Locate the configuration file "httpserver-powerstrip.ucf" (usually located in
C:\ti\CC3200SDK_1.0.0\cc3200-sdk\example\httpserver-powerstrip\html).
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5. When the screen shown in Figure 9 appears, put the correct COM port number of the LAUNCHXL
board connected to the "COM Port" box.

Figure 9. CCS UniFlash Screen After Configuration File Loaded

6. If this is the first time the board is being programmed, click "Format". Otherwise, go to Step 12.
7. When prompted to reset the device, push the button S1 once on the Wi-Fi module.
8. Wait for process to finish with the prompt "Operation Format returned".
9. Click on "Service Pack Programming" and locate the service pack bin file when prompted (located as

default in C:\ti\CC31xx_CC32xx_ServicePack_1.0.0.1.1\servicepack_1.0.0.1.1.bin).
10. When prompted to reset the device, push the button S1 once on the Wi-Fi module.
11. Wait for the process to finish with the prompt "Operation ServicePackProgramming returned".
12. Click on "Program" to start programming.
13. When prompted to reset the device, push the button S1 once on the Wi-Fi module.
14. Wait for the process to finish with the prompt "Operation Program returned".
15. Disconnect the Wi-Fi module and set SOP2 on the Wi-Fi board to the OFF position.

The Wi-Fi module is now programmed with the demo code and ready for use.
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5.2 Loading Firmware to TIDM-3OUTSMTSTRP
Perform the following steps to download the firmware to the TIDM-3OUTSMTSTRP hardware. Use an
MSP-FET430UIF MSP430 USB-Debug-Interface to perform the download.
1. Do not connect the Wi-Fi module to the metering board at this stage to program the TIDM-

3OUTSMTSTRP board.
2. Connect the MSP-FET430UIF to P1 of the TIDM-3OUTSMTSTRP and have J8 with position 1-2

shorted with a jumper. C21 may need to be removed temporarily for programming.
3. If Elprotronic FET-Pro-430 Lite is installed on PC, go to Step 7.
4. Go to https://www.elprotronic.com/productdata to download the FET-Pro-430 Lite Software.
5. Unzip the downloaded file and run setup.exe.
6. Follow the instructions to complete the install.
7. Launch FET-Pro-430 Lite.
8. Update the firmware if prompted for the MSP-FET430UIF Firmware Update.
9. Click on "Open Code File" and select "emeter-app-i2041.d43" inside the install folder of this design.

Then check the settings in the boxes Microcontroller Type, Power Device from Adapter, and Device
Action as shown in Figure 10.

NOTE: To modify code, use IAR 5.52 to compile the project "emeter-app-i2040". A compilation of
"emeter-metrology-i2040" and "emeter-toolkit-i2040" is not required. The library code of this
project is already provided. Contact a local Texas Instruments Sales office if the source code
for emeter-metrology-i2040 is required.

Figure 10. TIDM-3OUTSMTSTRP Programming Setup
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10. Click "READ/COPY" to copy the original code. When the Flash Memory Data window appears, click
the "Copy" button, paste the data to an open notepad application, and save it as a text file named
"original.txt". Use this file to restore the code to original in case of any errors.

Figure 11. Read Original Firmware
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Figure 12. Flash Memory Data Window; Copy and Save Original Firmware
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11. Close the Flash Memory Data window and click on "AUTO PROG".

Figure 13. Start Firmware Programming
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12. It will prompt the window shown in Figure 14. Check that everything else is okay except for "Verifying
Flash Memory".

Figure 14. Note Failure on Verify and Confirm Check Sum
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13. Click on View → Compare Code File and Flash Data. Select "Yes" when prompted to read the data
from the device first. Check for "==== No differencies found. ====" on the last line of the Comparation
Code and Flash Memory Data window (see Figure 16).

Figure 15. Perform Direct Code Comparison to Verify Written Firmware
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Figure 16. Comparation Code and Flash Memory Data Window

This completes the firmware programming of the TIDM-3OUTSMTSTRP.
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14. After the code is downloaded onto both boards, the application is ready to run. Put the Wi-Fi module
onto the communication connector of the TIDM-3OUTSMTSTRP board. Set the jumpers as shown in
Figure 17 and set DIP switch 4 on the Wi-Fi module to the ON position.

Figure 17. TIDM-3OUTSMTSTRP Board Jumper Settings
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6 Test Setup
To test the design, set up the hardware loaded with the firmware as described in Section 4 and Section 5.
Then apply AC voltage to the AC input of the power strip. The LEDs on the TIDM-3OUTSMTSTRP will
light up; the LED on the Wi-Fi should flash as well.

To start testing, use a smartphone, tablet, or PC with Wi-Fi. Look for the SSID "mysimplelink-XXXXXX"
(where "XXXXXX" is a six-digit hexadecimal number) and connect to it. Launch a browser and type in the
URL "mysimplelink.net".

The main page will be shown with the name of the meter in the upper left hand corner (which is
"MSP430i2040 3 SOCKET POWER STRI"). Then click on "Reading" so the following screen will appear:

Figure 18. Meter Reading Screen

7 Test Data

7.1 Reading Test
The voltage, current, active power, and power factor on each socket can be read from the displayed page
and is updated periodically (five-second intervals). Note if proper calibration is not done with the metering
hardware, the reading may not be accurate. To calibrate, follow the instructions in the TIDM-
3OUTSMTSTRP user’s guide.

7.2 Control Test
The power output to each socket can be controlled by clicking "ON" and "OFF" of the switches on the
page.
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8 Design Files

8.1 Schematics
To download the schematics, see the design files at TIDC-WIFI-METER-READING.

8.1.1 Metering Board
To download the schematics for the metering board, see the design files at TIDM-3OUTSMTSTRP.
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8.1.2 Wi-Fi Module

Figure 19. Schematic of Wi-Fi Module
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8.1.3 Power Supply Module

Figure 20. Schematic of Power Supply Module
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8.2 Bill of Materials
To download the bill of materials (BOM), see the design files at TIDC-WIFI-METER-READING.

8.2.1 Metering Board
To download the BOM for the metering board, see the design files at TIDM-3OUTSMTSTRP.

8.2.2 Wi-Fi Module

Table 1. Wi-Fi Module BOM

ITEM QTY DESIGNATOR VALUE DESCRIPTION MANUFACTURER PARTNUMBER FOOTPRINT
TIDM-1 1 !PCB Printed Circuit Board Any CC3200MOD_CONV

2 1 ANT 2.45-GHz Ant Chip antenna Taiyo Yuden AH316M245001-T AH316M
CAP, CERM, 1 pF, 50 V, +/- GRM1555C1H1R0BA03 1 C1 1pF MuRata 040210%, C0G/NP0, 0402 1D
CAP, CERM, 100 µF, 6.3 V, +/- GRM32ER60J107ME24 2 C2, C3 100uF MuRata 121020%, X5R, 1210 0L
CAP, CERM, 10 pF, 50 V, +/- GRM1555C1H100JA015 1 C4 DNP MuRata 04025%, C0G/NP0, 0402 D

6 1 D1 DFLS160 Diode, Schottky, 1A, 60V Diodes DFLS160 POWERDI_123
7 1 J1 Header, 4-Pin 3-644456-4 HDR1X4
8 1 J2 Header, 4-Pin 3-644456-4 HDR1X4

Connector, Ultra-Mini Coaxial, CONN_UFL-R-SMT-9 1 J3 Hirose Electric Co. Ltd. U.FL-R-SMT-1SMD 1
Connector, Micrwave, 50 Ohm CONN_MICRO-10 1 J4 MM8030-2600RJ3 murata MM8030-2600RJ3Coax MM8030-2600
Inductor, Film, 3.6 nH, 0.1 A, 1.311 1 L1 3.6nH MuRata LQP15MN3N6B02D LQP_0402ohm, SMD
Inductor, Film, 3.6 nH, 0.1 A, 1.312 1 L2 DNP MuRata LQP15MN3N6B02D LQP_0402ohm, SMD
Thermal Transfer Printable

13 1 LBL1 Labels, 0.650" W x 0.200" H - Brady THT-14-423-10 Label_650x200
10,000 per roll

14 1 LED1 Red Liteon LTST-C170KRKT 0805-LED
15 1 LED2 Green Liteon LTST-S220KGKT 0805-LED
16 1 LED3 Blue Liteon LTST-C170TBKT 0805-LED

MOSFET, N-CH, 50 V, 0.22 A,17 3 Q1, Q2, Q3 50V Fairchild Semiconductor BSS138 SOT-23SOT-23
R2, R7, R9, R20, R39,18 6 0 RES, 0, 5%, 0.063 W, 0402 Vishay-Dale CRCW04020000Z0ED 0402R59
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Table 1. Wi-Fi Module BOM (continued)
ITEM QTY DESIGNATOR VALUE DESCRIPTION MANUFACTURER PARTNUMBER FOOTPRINT

R3, R5, R11, R13, R15,
R17, R22, R23, R24,
R25, R26, R27, R29, CRCW04020000Z0ED19 23 DNP RES, DNP, 5%, 0.063 W, 0402 Vishay-Dale 0402R31, R32, R33, R34, (Phantom)
R35, R36, R37, R38,
R40, R58

20 3 R41, R42, R43 390 RES, 390, 5%, 0.063 W, 0402 Vishay-Dale CRCW0402390RJNED 0402
21 4 R44, R45, R47, R56 100k RES, 100 k, 5%, 0.063 W, 0402 Vishay-Dale CRCW0402100KJNED 0402
22 1 R46 2.7k RES, 2.7 k, 5%, 0.063 W, 0402 Vishay-Dale CRCW04022K70JNED 0402
23 1 R48 100 RES, 100, 5%, 0.063 W, 0402 Vishay-Dale CRCW0402100RJNED 0402
24 2 R49, R51 1.0k RES, 1.0 k, 5%, 0.063 W, 0402 Vishay-Dale CRCW04021K00JNED 0402

R50, R52, R53, R54,25 5 10k RES, 10 k, 5%, 0.063 W, 0402 Vishay-Dale CRCW040210K0JNED 0402R55
26 1 R57 0 RES, 0, 5%, 0.125 W, 0805 Vishay-Dale CRCW08050000Z0EA 0805_HV

SFM-110-02-SM-D-A- Header, SMT 10X2 pin, SFM-110-02-SM-D-A- HEADER_TFM-110-27 2 RF1B, RF2B SamtecK-TR Shrouded K-TR 02-SM
CONN SHRD HDR HDR 20 POS TFM-110-02-S-D-A-K- Samtec_TFM-110-28 2 RF1T, RF2T Samtec1.27MM SLDR ST SMD TR 02-S-D-A-K
Switch, Tactile, SPST-NO,29 3 S1, S2, S3 TE Connectivity 4-1437565-1 SW_FSM4JSMA0.05A, 12V, SMT
Switch, SPST, 4 Pos, Top30 1 SOP TE Connectivity 1571983-5 SW_1571983-5Actuated, SMD

31 1 U1 CC3200MOD

8.2.3 Power Supply Module

Table 2. Power Supply Module BOM

ITEM QTY DESIGNATOR VALUE DESCRIPTION MANUFACTURER PARTNUMBER FOOTPRINT
CAP, AL, 6.8uF, 400V, +/-20%, 400AX6R8M8x11(Alter CAPPRD350W60D8001 2 C1, C2 6.8uF RubyconTH nate: 400AX8.2M8X16 H1100
CAP, CERM, 220pF, 630V, +/- GRM31A7U2J221JW32 1 C3 220pF MuRata 12065%, U2J, 1206 1D
CAP, CERM, 4.7uF, 25V, +/- GRM21BC81E475KA13 1 C4 4.7uF MuRata 0805_HV10%, X6S, 0805 2L
CAP, TA, 470uF, 10V, +/-10%,4 1 C5 470uF AVX TPSE477K010R0045 7343-430.045 ohm, SMD
CAP, CERM, 1000pF, 50V, +/-5 1 C8 1000pF TDK C1608C0G1H102J 06035%, C0G/NP0, 0603
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Table 2. Power Supply Module BOM (continued)
ITEM QTY DESIGNATOR VALUE DESCRIPTION MANUFACTURER PARTNUMBER FOOTPRINT

CAP, CERM, 33pF, 1000V, +/- GRM31A7U3A330JW36 1 C9 33pF MuRata 12065%, U2J, 1206 1D
Diode, Switching-Bridge, 100V,7 1 D1 600V Fairchild Semiconductor MB6S TO-269AA0.5A, SOIC-4
Diode, Switching, 200V, 0.2A,8 1 D2 200V Diodes Inc. BAV21W-7-F SOD-123SOD-123
Diode, Superfast Rectifier, 600V,9 1 D3 600V Diodes Inc. DFLR1600 powerDI1231A, PowerDI123
Diode, Schottky, 40V, 10A,10 1 D4 40V Diodes Inc. PDS1040L-13 PowerDI5PowerDI5
2A Ferrite Bead, 600 ohm @11 1 FB1 600 ohm TDK MPZ2012S601A 0805_HV100MHz, SMD
Inductor, Unshielded Drum Core,

12 1 L1 470uH Ferrite, 470uH, 0.35A, 1.58 ohm, Wurth Elektronik eiSos 7447462471 IND_WE-TI_XS
TH
RES, 300k ohm, 1%, 0.25W,13 1 R1 300k Yageo America RC1206FR-07300KL 12061206
RES, 300 ohm, 1%, 0.25W,14 1 R2 300 Yageo America RC1206FR-07300RL 12061206

15 1 R4 22 RES, 22 ohm, 5%, 0.1W, 0603 Vishay-Dale CRCW060322R0JNEA 0603
16 1 R5 1.3k RES, 1.3k ohm, 5%, 0.1W, 0603 Yageo America RC0603JR-071K3L 0603
17 1 R6 36k RES, 36k ohm, 5%, 0.1W, 0603 Vishay-Dale CRCW060336K0JNEA 0603
18 1 R7 910k RES, 910k ohm, 5%, 0.1W, 0603 Vishay-Dale CRCW0603910KJNEA 0603

RES, 62k ohm, 5%, 0.125W,19 1 R8 62k Vishay-Dale CRCW080562K0JNEA 08050805
RES, 15 ohm, 5%, 0.125W,20 1 R9 15 Panasonic ERJ-6GEYJ150V 0805_HV0805

21 1 R10 3.9k RES, 3.9k ohm, 5%, 0.1W, 0603 Yageo America RC0603JR-073K9L 0603
22 1 T1 Transformer WURTH ELEKTRONIK 750841012

LOW STAND-BY POWER, CV /
CC PWM HV SWITCHER WITH23 1 U1 Texas Instruments UCC28910D D0007A_NPRIMARY SIDE REGULATION,
D0007A

29TIDUAM2A–September 2015–Revised October 2015 Wi-Fi Link for Energy Monitoring
Submit Documentation Feedback

Copyright © 2015, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAM2A


Design Files www.ti.com

8.3 PCB Layout
To download the layer plots, see the design files at TIDC-WIFI-METER-READING.

8.3.1 Metering Board
To download the PCB layout for the metering board, see the design files at TIDM-3OUTSMTSTRP.

8.3.2 Wi-Fi Module

Figure 21. Top Overlay Figure 22. Top Solder

Figure 23. Top Paste Figure 24. Top Layer
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Figure 25. Bottom Layer Figure 26. Bottom Paste

Figure 27. Bottom Solder Figure 28. Bottom Overlay
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Figure 29. Board Outline Figure 30. Board Dimensions

8.3.3 Power Supply Module

Figure 31. Top Overlay Figure 32. Top Solder

32 Wi-Fi Link for Energy Monitoring TIDUAM2A–September 2015–Revised October 2015
Submit Documentation Feedback

Copyright © 2015, Texas Instruments Incorporated

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDUAM2A


www.ti.com Design Files

Figure 33. Top Paste Figure 34. Top Layer

Figure 35. Bottom Layer Figure 36. Bottom Paste

Figure 37. Bottom Solder Figure 38. Bottom Overlay
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8.4 Altium Project
To download the Altium project files, see the design files at TIDM-3OUTSMTSTRP and TIDC-WIFI-
METER-READING.

8.5 Gerber Files
To download the Gerber files, see the design files at TIDM-3OUTSMTSTRP and TIDC-WIFI-METER-
READING.

8.6 Assembly Drawings
To download the assembly drawings, see the design files at TIDM-3OUTSMTSTRP and TIDC-WIFI-
METER-READING.
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9 Distributing Software Files
To download the software files, see the link at TIDC-WIFI-METER-READING.

The software files are distributed using a self-extracting executable file, which default to install onto TIDC-
WIFI-METER-READING-SOFTWARE on the user’s desktop.

Figure 39. Distribution Software
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Appendix A Importing Example to CCS

Before importing the example CCS project httpserver-powerstrip, it is assumed that:
1. CCS 6.0.1 with CC3200 support has been installed.
2. CC3200SDK 1.0.0 has been installed.
3. The software package for this TI Design has been downloaded and unzipped, and the "httpserver-

powerstrip" folder has been copied into the proper directory (default is:
C:\ti\CC3200SDK_1.0.0\cc3200-sdk\example).

To import the project:
1. Launch CCS 6.0.1.
2. When prompted for a workspace, select "C:\ti\CC3200SDK_1.0.0\cc3200-sdk\example" and click "OK".

Figure 40. Opening Workspace for CCS
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3. Select from Top Menu Project → Import CCS Projects…

Figure 41. Importing Project to CCS
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4. Choose "Select search-directory" and click "Browse" to import the project.

Figure 42. Project Import Window

5. When prompted, select the directory "C:\ti\CC3200SDK_1.0.0\cc3200-sdk\example" and click "OK".
6. In the "Discovered projects" box, check "httpserver-powerstrip" and click "Finish".
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IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated ("TI") reference designs are solely intended to assist designers (“Buyers”) who are developing systems that
incorporate TI semiconductor products (also referred to herein as “components”). Buyer understands and agrees that Buyer remains
responsible for using its independent analysis, evaluation and judgment in designing Buyer’s systems and products.
TI reference designs have been created using standard laboratory conditions and engineering practices. TI has not conducted any
testing other than that specifically described in the published documentation for a particular reference design. TI may make
corrections, enhancements, improvements and other changes to its reference designs.
Buyers are authorized to use TI reference designs with the TI component(s) identified in each particular reference design and to modify the
reference design in the development of their end products. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL
OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY THIRD PARTY TECHNOLOGY
OR INTELLECTUAL PROPERTY RIGHT, IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right,
or other intellectual property right relating to any combination, machine, or process in which TI components or services are used.
Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.
TI REFERENCE DESIGNS ARE PROVIDED "AS IS". TI MAKES NO WARRANTIES OR REPRESENTATIONS WITH REGARD TO THE
REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, EXPRESS, IMPLIED OR STATUTORY, INCLUDING ACCURACY OR
COMPLETENESS. TI DISCLAIMS ANY WARRANTY OF TITLE AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE, QUIET ENJOYMENT, QUIET POSSESSION, AND NON-INFRINGEMENT OF ANY THIRD PARTY
INTELLECTUAL PROPERTY RIGHTS WITH REGARD TO TI REFERENCE DESIGNS OR USE THEREOF. TI SHALL NOT BE LIABLE
FOR AND SHALL NOT DEFEND OR INDEMNIFY BUYERS AGAINST ANY THIRD PARTY INFRINGEMENT CLAIM THAT RELATES TO
OR IS BASED ON A COMBINATION OF COMPONENTS PROVIDED IN A TI REFERENCE DESIGN. IN NO EVENT SHALL TI BE
LIABLE FOR ANY ACTUAL, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES, HOWEVER CAUSED, ON ANY
THEORY OF LIABILITY AND WHETHER OR NOT TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, ARISING IN
ANY WAY OUT OF TI REFERENCE DESIGNS OR BUYER’S USE OF TI REFERENCE DESIGNS.
TI reserves the right to make corrections, enhancements, improvements and other changes to its semiconductor products and services per
JESD46, latest issue, and to discontinue any product or service per JESD48, latest issue. Buyers should obtain the latest relevant
information before placing orders and should verify that such information is current and complete. All semiconductor products are sold
subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.
TI warrants performance of its components to the specifications applicable at the time of sale, in accordance with the warranty in TI’s terms
and conditions of sale of semiconductor products. Testing and other quality control techniques for TI components are used to the extent TI
deems necessary to support this warranty. Except where mandated by applicable law, testing of all parameters of each component is not
necessarily performed.
TI assumes no liability for applications assistance or the design of Buyers’ products. Buyers are responsible for their products and
applications using TI components. To minimize the risks associated with Buyers’ products and applications, Buyers should provide
adequate design and operating safeguards.
Reproduction of significant portions of TI information in TI data books, data sheets or reference designs is permissible only if reproduction is
without alteration and is accompanied by all associated warranties, conditions, limitations, and notices. TI is not responsible or liable for
such altered documentation. Information of third parties may be subject to additional restrictions.
Buyer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements
concerning its products, and any use of TI components in its applications, notwithstanding any applications-related information or support
that may be provided by TI. Buyer represents and agrees that it has all the necessary expertise to create and implement safeguards that
anticipate dangerous failures, monitor failures and their consequences, lessen the likelihood of dangerous failures and take appropriate
remedial actions. Buyer will fully indemnify TI and its representatives against any damages arising out of the use of any TI components in
Buyer’s safety-critical applications.
In some cases, TI components may be promoted specifically to facilitate safety-related applications. With such components, TI’s goal is to
help enable customers to design and create their own end-product solutions that meet applicable functional safety standards and
requirements. Nonetheless, such components are subject to these terms.
No TI components are authorized for use in FDA Class III (or similar life-critical medical equipment) unless authorized officers of the parties
have executed an agreement specifically governing such use.
Only those TI components that TI has specifically designated as military grade or “enhanced plastic” are designed and intended for use in
military/aerospace applications or environments. Buyer acknowledges and agrees that any military or aerospace use of TI components that
have not been so designated is solely at Buyer's risk, and Buyer is solely responsible for compliance with all legal and regulatory
requirements in connection with such use.
TI has specifically designated certain components as meeting ISO/TS16949 requirements, mainly for automotive use. In any case of use of
non-designated products, TI will not be responsible for any failure to meet ISO/TS16949.IMPORTANT NOTICE
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